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MUC1002/1004/2008/2016 Upgrade Firmware Notice

 We strongly recommend you to back up the configurations before you
upgrade.

 You need to RESET the device to make it work properly if you want to
downgrade the firmware.

 Backup files from higher firmware version cannot be restored to the device
with lower firmware version.

 It’s recommended that you clear the browser cache after upgrade
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 Release Notes of Version 20/1/12/13.1.0.29-beta06

1. Introduction

(1) Firmware Version: 20.1.0.29-beta06,1.1.0.29-beta06,12.1.0.29-beta06,13.1.0.29-beta06

(2) Applicable Model:MUC1002,MUC1004,MUC2008,MUC2016

(3) Release Date: July 29, 2019

CHANGES SINCE FIRMWARE RELEASE 20/1/12/13.1.0.29-beta05

2. New Features
None
3. Optimization

(1) Repackage the image to facilitate customer identification. Upgrade the database
version to avoid online upgrade image, database is not updated.

4. Bug Fixes
None
5. New Features Descriptions

None
6. Optimization Description

(1) Repackage the image to facilitate customer identification. Upgrade the database
version to avoid online upgrade image, database is not updated.

7. Bug Fixes Description
None.
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 Release Notes of Version 20/1/12/13.1.0.29-beta05

1. Introduction

(1) Firmware Version: 20.1.0.29-beta05,1.1.0.29-beta05,12.1.0.29-beta05,13.1.0.29-beta05

(2) Applicable Model:MUC1002,MUC1004,MUC2008,MUC2016

(3) Release Date: July 22, 2019

CHANGES SINCE FIRMWARE RELEASE 20/1/12/13.1.0.29-beta04

2. New Features
None
3. Optimization

(2) On the basis of the original Call Group function, add, modify, or remove the Call Group
will directly modify the relevant data of the queues, extension and Ring Groups that has
been added with Call Group.

(3) Modifying or deleting the extension will directly modify the data of the added Call
Group and the queue and ring group corresponding to the Call Group.

(4) Compatible with Agent Info in Call Center to display Agent status.

4. Bug Fixes
None
5. New Features Descriptions

None
6. Optimization Description

(2) On the basis of the original Call Group function, add, modify, or remove the Call
Group will directly modify the relevant data of the queues, extension and Ring Groups
that has been added with Call Group.

Figure ->6.1 Add extension 100 to Call Group “test”
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Figure ->6.2 Add Call Group “test” to Queue 820

Figure ->6.3 Add Call Group “test” to Ring Group 920

Figure->6.4 Add extension 101 to Call Group “test”
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Figure->6.5 Call Group “test” in Extension 101

Figure->6.6 After added Extension 101 in Queue 820
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Figure->6.7 After added Extension 101 in Ring Group 920

(3) Modifying or deleting the extension will directly modify the data of the added Call
Group and the queue and ring group corresponding to the Call Group.

Figure->6.8 Before delete Extension 200
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Figure->6.8 After deleted Extension 200
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(4) Compatible with “Agent Info” in Call Center to display Agent status.
Figure->Before Optimization
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Figure->After Optimization

7. Bug Fixes Description
None.

http://www.maxincom.com/


MAXINCOM TECHNOLOGYCO.,LTD
www.maxincom.com

20

 Release Notes of Version 20/1/12/13.1.0.29-beta04

1. Introduction

(1) Firmware Version: 20.1.0.29-beta04,1.1.0.29-beta04,12.1.0.29-beta04,13.1.0.29-beta04

(2) Applicable Model:MUC1002,MUC1004,MUC2008,MUC2016

(3) Release Date: June 20, 2019

CHANGES SINCE FIRMWARE RELEASE 20/1/12/13.1.0.29-beta03

2. New Features
None
3. Optimization

(1) In the queue, move the extension to the dynamic agent. The corresponding number
in the static agent should be removed.

(2) Delete one of extensions in the Call Group, and the corresponding Call Group, queues
and ring groups containing this extension will automatically delete this extension.
When the deleted extension is the last member of the Call Group, the Call Group will
be deleted together.

4. Bug Fixes

(1) In the initial state, the extension dials 820 or 920, it can't get through. You need to
save it again before you can get through.

(2) The test of "Number" in Call Forward in the extension interface failed.

(3) In the initial state, after deleting the extension, the same extension number in the
queue has not been deleted.

5. New Features Descriptions
None.

6. Optimization Description

(1) In the queue, move the extension to the dynamic seat. The corresponding number in
the static seat should be removed.

Path :PBX Inbound Call Control->Queues->Add Queue(Edit Queue)
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Figure ->6.1 Before move 101

Figure->6.2 After move 101

(2) Delete one of extensions in the Call Group, and the corresponding Call Group, queues
and ring groups containing this extension will automatically delete this extension.
When the deleted extension is the last member of the Call Group, the Call Group will
be deleted together.
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7. Bug Fixes Description

(1) In the initial state, the extension dials 820 or 920, it can't get through. You need to
save it again before you can get through.

(2) The test of "Number" in Call Forward in the extension interface failed.
Figure->7.1 Use “Number” in extension

There are two registered extensions 101 and 104, as shown in the figure above, set the value of
“Number” to 101 in extension 102 (extension 102 is not available), then extension 104 dials
extension 102 and waits for the dial result.
Before Fixed:
There's no ring on extension 101.
After Fixed:
After hearing a voice prompt, extension 101 started ringing.

(3) In the initial state, after deleting the extension, the same extension number in the
queue has not been deleted.
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 Release Notes of Version 20/1/12/13.1.0.29-beta03

1. Introduction

(1) Firmware Version: 20.1.0.29-beta03,1.1.0.29-beta03,12.1.0.29-beta03,13.1.0.29-beta03

(2) Applicable Model:MUC1002,MUC1004,MUC2008,MUC2016

(3) Release Date: June 5, 2019

CHANGES SINCE FIRMWARE RELEASE 20/1/12/13.1.0.29-beta02

2. New Features
None
3. Optimization
None
4. Bug Fixes
(1) Fixed outside call problems
5. New Features Descriptions
None
6. Bug Fixes Description

(1) Fixed an issue with an outside line failing to call directly into an extension via the SIP
Trunk
Preparation for the test:
Register extensions 206 and 101 on two different IPPBX (such as 192.168.6.97 and 192.168.6.48),
register the SIP Trunk(48pbx) on 97, and remove one bit from the dial rule configured in 97.

Figure 1-1SIP Trunk of 48pbx in 192.168.6.97

Figure 1-2SIP Trunk of 97 in 192.168.6.48

Figure 1-3Outbound Routes of 48 in 192.168.6.97
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Dial Test：
<1> Before Fixed:
When the SIP Trunk (97) is registered on 48 but the inbound route with the 97 relay is not

registered, dial 1101 on 206 and you will not be able to connect to extension 101.
<2>After Fixed:
When the SIP Trunk (97) is registered on 48 but the inbound route with the 97 relay is not

registered, dial 1101 on 206 and you can connect to extension 101.
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 Release Notes of Version 20/1/12/13.1.0.29-beta02

1. Introduction

(1) Firmware Version: 20.1.0.29-beta02,1.1.0.29-beta02,12.1.0.29-beta02,13.1.0.29-beta02

(2) Applicable Model:MUC1002,MUC1004,MUC2008,MUC2016

(3) Release Date: May 6, 2019

CHANGES SINCE FIRMWARE RELEASE 20/1/12/13.1.0.29-beta01

2. New Features
(1) Call Groups Settings in PBX Basic
3. Optimization
None
4. Bug Fixes
None
5. New Features Descriptions

(1) Call Groups Settings in PBX Basic
Path: PBX Basic->Call Groups Settings

Description:

Add “Call Groups Settings” function. Multiple extensions can be added quickly in the “Queues” and
“Ring Groups” function, and can also be used for the “Pick Up” function.

Test Progress:
<1> Call Groups and Extensions

Figure->Add Call Group
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Figure->After Added for 601

Figure->After Added for 102

Description:

Add the Call Group (aaa) as shown above. “aaa” should be added to “Enabled Call Groups” in the
respective extensions of 601 and 102. At the same time, when the mouse hovers over “aaa”, you
can see the members of “aaa”.
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Figure->Before Add Call Group in Extension

Figure->After Add Call Group in Extension

Description:

As shown in the figure above, after adding aaa to Enabled Call groups, the extension of 103 can see
that the members of aaa have changed when hovering over aaa.
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Figure->Before Remove members from Enabled Call Groups

Figure->After Remove members from Enabled Call Groups

Description:

If a Call Group has only one member, when the extension interface removes the call group, the Call
Groups are deleted directly. For example, the member of bbb in the above figure has only one 104
extension.
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Figure->Set Pick Up Groups

Description:

As shown in the figure above, Enabled Pick Up Groups of extension 102 selects call group(bbb) with
extension 104. When extension 101 dials extension 104 and extension 104 rings, extension 102 can
intercept by press *8. If the extension 104 dials the extension 101 and the extension 101 rings, the
extension 102 cannot intercept the extension 104. In short, the intercept function only intercepts
the called party (when using *8).

<2> Queue and Call Groups
Figure->Set Call Groups

Description:
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As shown in the figure above, the actual members of queue 820 are 105, 104, 103, 601, and 102.
The members in call group(aaa) have been compared with other extensions (105, 104, and 102),
and duplicate extensions are removed.

<3> Ring Groups and Call Groups
Figure->Set Call Groups

Description:

As shown in the figure above, the actual members of ringgroups920 are 102 104, 601 and 103.

The members in call group(aaa) have been compared with other extensions (102, 104 and 601)and
duplicate extensions are removed.

6. Bug Fixes Description

none
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 Release Notes of Version 20/1/12/13.1.0.29-beta01

1. Introduction
(1) Firmware Version:
20.1.0.29-beta01,1.1.0.29-beta01,12.1.0.29-beta01,13.1.0.29-beta01

(2) Applicable Model:MUC1002,MUC1004,MUC2008,MUC2016

(3) Release Date: April 15, 2019

CHANGES SINCE FIRMWARE RELEASE 20/1/12/13.1.0.29

2. New Features
(1) Concurrent Registration of Extensions

(1) Encrypt the parameters displayed by the url path.
3. Optimization
None
4. Bug Fixes
(1) The user registered with User permission in the monitor account cannot log in

(2) The Fanvil phone failed to manually add a MAC address.
5. New Features Descriptions
(1) Concurrent Registration of Extensions

Figure->Call Groups

Path: PBX Basic->Extensions

Description:

Add the “Concurrent Registrations” function, the same extension number can be registered to
multiple phones, at least one and up to five. When other extensions dial in, all phones registered
with this extension number will ring at the same time. Compatible with “Queues” and “Ring Groups”
function.

Test Progress:
<1>Configure the “Concurrent Registrations” option in the extension page, if set to 3.

Figure->Set Concurrent Registrations of 102
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<2>The extension 102 is separately registered on the three telephones. The “Username” or “SIP
UserID” options on the phone should be filled in the order of 102, 102sip1 and 102sip2. By analogy,
if the number of concurrent registrations is 5, the registered accounts are 102, 102sip1, 102sip2,
102sip3 and 102sip4. The passwords are the same.

Figure->Account of 102

Figure -> Account of 102sip1

Notes: When the same extension number is registered on a different extension, the newly
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registered phone ip address will replace the previous ip address.
Figure -> Account of 102sip2 for 192.168.6.166

Figure -> Account of 102sip2 for 192.168.6.163

The displayed of extension status is change from:
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to:

<3> Registration completion diagram and dialing process.
Figure->Register 101 extension and 102 extension for dial test.

101 extension dials 102 extension
Figure->Ringing

Figure->Answered

<4> Queues and Ring Groups Testing

Adding extensions 102 to the Queues(820) and Ring Groups(920), and then dialing 820 and 920
through extension 101, it can be seen that the plurality of telephones registered by the extension
102 are ringing at the same time.

<5> CDR Display Situation

When the extension 101 dials 820 and 920, if any one of the plurality of telephones registered at
the extension 102 is answered, the CDR Report will display the account name of the telephone.
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(2) Encrypt the parameters displayed by the url path to avoid being directly modified by others.

Figure->Add User in Admin

Figure->Add User in Monitor

Figure->Before Encrypt

Figure->After Encrypt
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6. Bug Fixes Description
(1) The user registered with User permission in the monitor account cannot log in

(2) Fixed the problem that the Fanvil phone failed to manually add a MAC address.

Figure->Before Fixed

Figure->After Fixed
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 Release Notes of Version 20/1/12/13.1.0.29

1. Introduction

(1) Firmware Version: 20.1.0.29,1.1.0.29,12.1.0.29,13.1.0.29

(2) Applicable Model:MUC1002,MUC1004,MUC2008,MUC2016

(3) Release Date: March 5, 2019

CHANGES SINCE FIRMWARE RELEASE 20/1/12/13.1.0.28-beta03

2. New Features
(1) Announcement in Paging and Intercom
3. Optimization
None
4.Bug Fixes
None
5.New Features Descriptions

(1)Announcement in Paging and Intercom
Figure->view system date

Figure->Do not enable play announcement function

Figure-> enable play announcement function

http://www.maxincom.com/


MAXINCOM TECHNOLOGYCO.,LTD
www.maxincom.com

38

Figure->Enable auto-play announcements

Figure->Set the specific time of the auto-play announcement

Path: PBX Advanced Settings->Paging and Intercom

Description:
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Add the "Announcement" and "Repeat Times" options and update the "Time" setting. The Paging
Groups feature is divided into the Enable Broadcast Announcement feature and is not enabled.
Among them, the broadcast announcement function is divided into manual and automatic timing.
The manual broadcast function broadcasts an announcement to the called party through the system
after the calling party and the called party are connected. After the announcement is over, the
calling party and the called party can make a call. If the "Duplex" option is enabled, all phones in the
paging group are allowed to talk and be heard by all; if "Duplex" is not enabled, the caller can only
speak, while other members can only hear and not participate in the call. The Auto play function is
done by setting the time in "Time List". When system time reaches a specified point in time, all
selected available extensions automatically answer and play the announcement, and then hang up
automatically when the playback is complete.

NOTICE: When the timing broadcast function is enabled, the set time interval cannot be lower than
the time length of the announcement. If the announcement time is 2 minutes, the timing is not
allowed at 11:30 and 11:31.

Figure->MUC1004 PBX Maximum number of members in manual mode

Figure->MUC1004 PBXMaximum number of members in automatic mode

Figure->MUC1004 PBX Maximum number of members for announcement mode is not enabled
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Description:

Due to IPPBX performance constraints, the maximum number of "Members" in the Paging
Groups of the four types of PBX of MUC1002 / MUC1004 / MUC2008 / MUC2016 is
different. As shown in the figure above, the maximum number of members for MUC1004
automatic mode is 9, the maximum number for manual mode is 7, and the maximum
number for unenabled announcement mode is 14. At the same time, the maximum number
of members of MUC1002 automatic mode is 5, that of manual mode is 4, and the maximum
number of members of unenabled announcement mode is 9. The maximum number of
members in MUC2008 auto mode is 20, the maximum number of members in manual
mode is 15, the maximum number of members unenabled announcement mode is 30. The
maximum number of members in Muc2016 auto mode is 30, and the maximum number of
members in manual mode is 24. the maximum number for unenabled announcement mode
is 49. When a member exceeds the maximum limit, one or more extensions fail to hang up.
To avoid this, it is recommended that the number of registered members should not exceed
the smaller value in manual and automatic mode, or disable "Set Time" before using
manual mode. If there is a failure to hang up, you need to restart PBX.

Figure->Announcement content recording and uploading

Path: Voice Management->System Recordings

Description: Announcements can be recorded via the Record new Prompt button or
uploaded via the Upload button. The announcement file format must be a gsm file.

6.Bug Fixes Description

none
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 Release Notes of Version 20/1/12/13.1.0.28-beta03

1. Introduction

(1) Firmware Version:
20.1.0.28-beta03,1.1.0.28-beta03,12.1.0.28-beta03,13.1.0.28-beta03

(2) Applicable Model:MUC1002,MUC1004,MUC2008,MUC2016

(3) Release Date: January 18, 2019

CHANGES SINCE FIRMWARE RELEASE 20/1/12/13.1.0.28-beta02

2. New Features

None
3. Optimization

None
4. Bug Fixes
(1)PBX Advanced Settings->SIP Settings: After the Local Network is saved, some data is
lost.
5. New Features Descriptions

None
6. Bug Fixes Description
(1)PBX Advanced Settings->SIP Settings:After the Local Network is saved, some data is
lost.

Figure->Before fixed the bug
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Figure-> Saved before fixed the bug

Figure-> Saved after fixed the bug

Figure->The maximum number of additions is limited to 10
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Path: PBX Advanced Settings->SIP Settings

Description: Before the bug is fixed, when the Local Network is saved, some data is lost.
After the bug is fixed, the data will not be deleted, and the maximum number of additions
is limited to 10.
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 Release Notes of Version 20/1/12/13.1.0.28-beta02

1. Introduction

(1) Firmware Version:
20.1.0.28-beta02,1.1.0.28-beta02,12.1.0.28-beta02,13.1.0.28-beta02

(2) Applicable Model:MUC1002,MUC1004,MUC2008,MUC2016

(3) Release Date: December 12, 2018

CHANGES SINCE FIRMWARE RELEASE 20/1/12/13.1.0.28-beta01

2. New Features
(1) Added “Voicemail List” on “Reports”

3. Optimization

(1) Optimized the save of special destination in Inbound Route.

4. Bug Fixes

5. New Features Descriptions
(1) Added “Voicemail List” on “Reports”

Figure->Voicemail List in Admin

Figure->Voicemail List In Extension

Path: Reports->Voicemail List
Description: Integrate the voicemail records of each extension into the Admin interface for
unified processing. In the Admin page,
(1) Add Destination to distinguish each extension.
(2) To integrate date and time together, easy to sort by time.
(3) Add destination in the Filter.

6. Optimization Description
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Figure->Special Time List is empty

Figure->Special Time List isn’t empty

Path: PBX Inbound Call Control->Inbound Routes

Description: When the Special Time List and Special Destination are both empty, clicking
Save will not prompt an error. When the Special Time List is not empty and the Special
Destination is empty, clicking Save will prompt an error.
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 Release Notes of Version 20/1/12/13.1.0.28-beta01

1. Introduction

(1) Firmware Version:
20.1.0.28-beta01,1.1.0.28-beta01,12.1.0.28-beta01,13.1.0.28-beta01

(2) Applicable Model:MUC1002,MUC1004,MUC2008,MUC2016

(3) Release Date: November 9, 2018

CHANGES SINCE FIRMWARE RELEASE 20/1/12/13.1.0.28

2. New Features
(1) Added “Special Time Groups” on “Inbound Routes”

3. Optimization

(1) Optimized the display of outbound CID in cdr report source

4. Bug Fixes

5. New Features Descriptions
(1) Added “Special Time Groups”on“Inbound Routes”

Figure->Special Time Groups

Path: PBX Inbound Call Control->Inbound Routes-->Add Route(Edit Route)
Description: You can route calls to different destination at different times. Calls that do
not match the time periods will be routed to Other Time destination. If all the set time
periods do not match, they will be transferred to Night Destination.
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6. Optimization Description

(1) Optimized the display of outbound CID in cdr report source
Figure->Before optimization

Figure->After optimization

Path: Reports->CDR Reports

Description: The number(568932) is CID number of Outbound Route. The number(202 and
201) is Calling number. The optimized CID number will be accompanied by the calling
number.
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 Release Notes of Version 20/1/12/13.1.0.28

1. Introduction

(1) Firmware Version: 20.1.0.28,1.1.0.28, 12.1.0.28,13.1.0.28

(2) Applicable Model:MUC1002,MUC1004,MUC2008,MUC2016

(3) Release Date: October 29, 2018

CHANGES SINCE FIRMWARE RELEASE 1/12/13.1.0.27

2. New Features
(1) Add X series phone of Fanvil.

3. Optimization

4. Bug Fixes

5. New Features Descriptions
(1) Add X series phone of Fanvil.

Figure1->Web edit phone

Path: Phone Provisioning -->Phones
Description: The new X-series fanvil phones are modeled as 'X3S', ‘X4’, ‘X5S’ and ‘X6’. X3S
has 2 SIP Lines, 2 DSS Keys; X4 has 4 SIP Lines, 30 DSS Keys; X5 has 6 SIP Lines, 40 DSS Keys;
X6 has 6 SIP Lines and 60 DSS Keys.
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Figure2->New items about Type

Figure2:Added BLF List Key and Action URL

Figure3->New items about Sub Type of Memory Key

Figure3:Replace the original BLF with BLF/NEW CALL, BLF/BXFER, BLF/AXFER,
BLF/CONFERENCE and BLF/DTMF in Memory Key

http://www.maxincom.com/


MAXINCOM TECHNOLOGYCO.,LTD
www.maxincom.com

50

Figure4->New items about Sub Type Key Event

Figure4:New options such as Reset to factory default in Key Event
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 Release Notes of Version 1/12/13.1.0.27

1. Introduction

(1) Firmware Version: 1.1.0.27, 12.1.0.27,13.1.0.27

(2) Applicable Model:MUC1004,MUC2008,MUC2016

(3) Release Date: August9,2018

CHANGES SINCE FIRMWARE RELEASE 1/12/13.1.0.22

2. New Features
(1) Added Portuguese (Brazil customer).

(2) Added “VPN Server” on “Network Configuration”

(3) Added “VPN Client” on “Network Configuration”

(4) Increase the Time Zone configuration of the Htek phone Phone Prov

(5) Added “LDAP Server” on “PBX Advanced Settings”

(6) Added “operator” on “Voice Management->Voicemail Settings”

(7) Added “User Permission” on “monitor->Advanced Settings”

(8) Added “Callback When Busy”

(9) Added “Three-way Conferences”

(10)Added “Import and Export” on “admin -> PBX Basic->Extensions”

3. Optimization

4. Bug Fixes

(1) Fix the first GSM trunk in the outgoing route is in the call, the second call out cannot
pass the next trunk error

(2) Queue password limit adjustment

5. New Features Descriptions
(1) Added Portuguese (Brazil customer).

Path: PBX Basic -->General Settings
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Figure-Portuguese

(2) Added “VPN Server” on “Network Configuration”

Figure->VPN Server

Path: Network Configuration-->VPN Server

(3) Added “VPN Client” on “Network Configuration”

Figure->VPN Client

Path:Network Configuration -->VPN Client

http://www.maxincom.com/


MAXINCOM TECHNOLOGYCO.,LTD
www.maxincom.com

53

(4) Increase the Time Zone configuration of the Htek phone PhoneProv

Figure-->Time zone

(5) Added “LDAP Server” on “PBX Advanced Settings”

Figure->LDAP Server

Path: PBX Advanced Settings->LDAP Server

Description: The main idea of LDAP is to keep in one place all the information of a user
(contact details, login, password), so that it is easier to maintain by network administrators.
For example you can:

• use the same login/password to login on an Intranet.

• get all the contact details of the people in a company on Outlook for example.

LDAP is used as a phone book on PBX so that you can search a key word from your
IP phone.
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(6) Added “operator” on “Voice Management->Voicemail Settings”

Figure->operator

Path: Voice Management->Voicemail Settings

Description: when leaving a voicemail allow sender to hit 0 to reach an IVR.

(7) Added “User Permission” on “monitor->Advanced Settings”

Login with username: monitor

Path: Advanced Settings --> User Permission

Descriptions: Add user permission functionality to Monitor, create new users and allow
users to control what is displayed in the web page. Options are USB devices,
Recording Settings and Call Detail Records

Figure-> User Permission
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Figure- Add User Permission

Figure-Edit User Permission

Figure- User Interface

After you have created a new user, you need to go back to the login page, enter the user
name and password of the new user, and enter the user interface.

(8) Added “Callback When Busy”

Descriptions: When the callee user is on the phone, after hearing the prompts, then
dial 5 to enable this function, hang up. Within 10 seconds after the callee user hangs up,
the caller user will ring the bell first, and when connected, the callee user will ring the
bell. The maximum waiting time for the callee user hangs up is 20 minutes. For timeout,
repeat the operation.

The conditions for the callback to be effective are:

Path: PBX Basic-> extensions- > Edit VoIP (FXS) Extensions-> Options-> Call Forward->
When Busy .The ‘When Busy’ option not enabled.
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Figure-Callback effective condition 1

Path: PBX Basic-> extensions- > Edit VOIP (FXS) Extensions-> Options->
Voicemail->Enable Voicemail. The ‘Enable Voicemail’ option not enabled.

Path: PBX Basic-> extensions- > Edit VOIP (FXS) Extensions-> Options-> Call Forward->
When Busy and Voicemail. The ‘When Busy’ option and ‘Voicemail’ option enabled.

Figure-Callback effective condition 2

Notes:
(1) Modify: The ‘When Busy’ is not enabled by default.
(2) If the option ‘Always’ enabled in Call Forward, the Callback When Busy will not effective.
(3)If you want to enable other functions when busy, such as Voicemail, Number or Hang
up.You need to enabled the option ‘when Busy’.
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(9) Added “Three-way Conferences”
Descriptions: To invite others into the conference room during the call.
Operating Process, for example:
Step 1:Prepare three extensions,101,102,103.
Step 2:Extension 101 dial 102,extension 102 answered. At this time, extension 101 dial
*00,extension 101 to hear the dial tone, extension 102 enter the conference room 860
and hear the waiting music.
Step 3:During the dial tone, extension 101 dial 103#,then extension 103 ringing and
answered it. After that, extension 101 dial *11, extensions 101, 102, and 103 enter
conference room 860 together.

Notes:
(1) The callee user dial *00 will not make a correct Three-way conferences.
(2) Three-way conferences with external calls is not be effective.
(3) The dial tone lasts about 10 seconds. If you do not dial the extension number you

want to invite, the caller（ such as 101） and the callee (such as 102) will enter the
conference room automatically. In this moment, the callee(102) can invite a new user(such
as 103) into the conference room by dialing 0 and then following Step 3.

(4) At present, the three-party calling function is only implemented when an internal call is

made, and the incoming call through the external relay cannot be realized.

(10)Added “Import and Export” on “admin -> PBX Basic->Extensions”

Login with username: admin

Path: PBX Basic->Extensions->Import(Export)

Descriptions: Add Import and Export functionality to Extensions, then user can import
the new extensions by filling a fixed format CSV form and using the import function. You
can also export the total extensions via the export function.

Figure-Import and Export
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Figure->CSV File Content

We will provide you with a template for uploading files, you only need to modify the
content of the green area

Figure->Import Success graph

Figure->Export Success graph
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 Release Notes of Version 1/12/13.1.0.22

1. Introduction

(1) Firmware Version: 1.1.0.22, 12.1.0.22,13.1.0.22,

(2) Applicable Model:MUC1004,MUC2008,MUC2016

(3) Release Date: Aug8,2018

CHANGES SINCE FIRMWARE RELEASE 1/12/13.1.0.18

2. New Features
(1) Added fax t38 and t38 configuration to the outbound route.

(2) Added Myanmar time option on device Date function

(3) Added “Morning Call” on “PBX Advanced Settings”

(4) Added “SMS Settings” on “PBX Advanced Settings”

(5) Added “User Permission” on “System Preferences”

(6) Added outbound route memory trunk configuration

(7) Added“modelGXP1610/1615-GXP1620/1625-GXP1628-GXP1630” on “Phone
Provisioning->Phones->Grand stream”

(8) Added the Txgain option of the FXO line

(9) Added Echo Train in General and select the set echo train time value.

(10) Added CUSTOM option (at the end of the list of options) on FXO Mode.

(11) AddedHtekUC902/UC903/UC923/UC924/UC926 model support to Phone Provisioning

3. Optimization
(1) The time zone option values of grandstream and yealink are synchronized to the
latest version of the phone.

(2) Modify the reset time of the MUC series device 8s --> 4s

4. Bug Fixes

(1) Fixed an error that did not hear the MOH sound when the incoming route was set to
the queue.

(2) Fixed click on the fxs extension on the extension status page to enter the edit page to
return data error.

(3) Fixed the error that the extension range value that fxs can set is different from the set
extension range.

(4) Fixed MUC1004 multi-way call, reset does not take effect.

(5) Fixed deleting the fxs port causes the optional extension box to be empty when
adding the outbound route

(6) Fixed an error that the extension number cannot be saved when the extension fxs
extension exceeded the extension range
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(7) Fixed fxs extension web page transfer number not displayed error.

(8) Fixed the value of dst in cdr of reminder Call is s error.

5. New Features Descriptions
(1) Added fax t38 and t38 configuration to the outbound route.

Path: PBX Basic -->Outbound Routes

Descriptions: T38 is a protocol on how to send and receive faxes over a
computer network.

Figure->t38

(2) Added Myanmar time option on device Date function

Figure->Myanmar

Path: System Preference-->Time& Date
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(3) Added “Morning Call” on “PBX Advanced Settings”

Figure->Delete FXS Extension

Path:”PBX Advanced Settings”-->”Reminder Call”
Description: Extension alarm function, you can set alarms for multiple extensions at the
same time

(4) Added “SMS Settings” on “PBX Advanced Settings”
Figure->SMS Settings

Path: PBX Advanced Settings-->SMS Settings
Description: The purpose of SMS Settings is to send an email to a mailbox or send a text
message to a mobile phone via email.
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(5) Added “User Permission” on “System Preferences”
Figure->User Permission

Path: System Preference-->User Permission
Description: Create new users and let users control what the page displays

(6) Added outbound route memory trunk configuration
Figure->Memory Trunk

Path: PBX Basic->Outbound Routes

Descriptions: Remember last dial out trunk and use next available trunk.

(7) Added “model GXP1610/1615-GXP1620/1625-GXP1628-GXP1630” on “Phone
Provisioning->Phones->Grandstream”
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Figure->Grandstream

(8) Added the Txgain option of the FXO line

Figure->Against

Description: Used to modify the volume level of this trunk. Normally, this setting does not need to
be changed.

(9) Added Echo Train in General and select the set echo train time value.

Figure->Echo Train
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(10)Added CUSTOM option (at the end of the list of options) on FXO Mode.

Figure->Custom
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(11)Added Htek UC902/UC903/UC923/UC924/UC926 model support to Phone
Provisioning
Path: Phone Provisioning -->Phones -->Add Phone

Figure->Htek

http://www.maxincom.com/


MAXINCOM TECHNOLOGYCO.,LTD
www.maxincom.com

66

 Release Notes of Version 1/12/13.1.0.18

1. Introduction

(1) Firmware Version: 1.1.0.18, 12.1.0.18,13.1.0.18,

(2) Applicable Model:MUC1004,MUC2008,MUC2016

(3) Release Date: Nov 16,2016

CHANGES SINCE FIRMWARE RELEASE 1/12/13.1.0.14

2. New Features

(1) Added “FXS Del Option” on “ FXS Extensions”

(2) Added “Rtp Port End” on “SIP Settings”

(3) Added Select All and Cancel All widget on Selection box

(4) Added “Report IP Address” on “Feature Codes”

(5) Added pt_BR System Prompts on “System Prompts Settings”

(6) Added “Send Privacy id” on “SIP Settings”

(7) Added “Send Diversion” on “SIP Settings”

3. Optimization

(1) Optimized the WAN port to the priority port

(2) Increase the length of the SIP Trunk field input

4. Bug Fixes

(1) Fixed the issue that SIP Trunk DOD not work properly For “From User” field error

5. New Features Descriptions

(1) Added “FXS Del Option” on “ FXS Extensions”

Path: PBX Basic --> Extensions --> FXS Extensions

Descriptions: Click delete FXS extension, Web Page will retain the edit option,
enter the edit page, you can modify FXS extension number

Figure->FXS Status
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Figure->Delete FXS Extension

Figure->Edit Deleted FXS Extension

Figure->Extension Scope

New Fxs extension number is in extension scope

In Fxs deleted edit web page, modify extension number will adjust following field
at the same time

Display Name

Caller ID Number

PIN Number

Extension web Login Name and Password

(2) Added “Rtp Port End”on “SIP Settings”

Path: PBX Advanced Settings --> SIP Settings

Descriptions: Easy to fill out and view the value of rtp port range.
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Figure->Rtp Port End

(3) Added Select All and Cancel All widget on Selection box

For example in outbound edit page

Figure->select all and cancel all

http://www.maxincom.com/


MAXINCOM TECHNOLOGYCO.,LTD
www.maxincom.com

69

(4) Added “Report IP Address” on “Feature Codes”
Path: PBX Basic --> Feature Codes --> Report IP Address

Descriptions: Dial ***，System will play prompt of local IP.

Figure->Report IP Address

(5) Added pt_BR System Prompts on “System Prompts Settings”
Path: Voice Management --> System Prompts Settings

Descriptions: Add a new System Prompts of Portuguese Brazil

Figure->System prompts of Portuguese Brazil

(6) Added “Send Privacy id” on “SIP Settings”

(7)Added “Send Diversion” on “SIP Settings”

Path: PBX Advanced Settings --> SIP Settings

Descriptions:

send Privacy header to enable anonymous call feature

send Diversion header to enable caller id Pass-Through feature when forward
through SIP trunk
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Figure->SIP Advance Settings

6. Optimization Descriptions

(1) Optimized the WAN port to the priority port

Path: PBX Basic --> Network Configuration --> Static Route

Descriptions: By default, the WAN port routing priority is higher than the LAN
port

Figure->WAN and LAN static route

If you have configure WAN port before, you may need to reset pbx
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 Release Notes of Version 1/12/13.1.0.14

1. Introduction

(1) Firmware Version: 1.1.0.14, 12.1.0.14,13.1.0.14

(2) Applicable Model:MUC1004,MUC2008,MUC2016

(3) Release Date: July 04,2016

CHANGES SINCE FIRMWARE RELEASE 1/12/13.1.0.5

2. New Features

(1) Added “Security Info” on “System Preferences”

(2) Added “AMI Settings” on “System Tools”

(3) Added “Mobility Extension” on Extensions

(4) Added extension Maximum Call Duration and global Maximum Call Duration

(5) Added dod and add bulk dod on “IP Trunk” and “VOIP Trunk”

(6) Added Extension CDR Report on Extension Web Login

3. Optimization

(1)None

4. Bug Fixes

(1)None

5. New Features Descriptions

(1) Added “Security Info” on “System Preferences”

Path: System Preferences->Security Info

Alert Settings: if the device is attacked, the system will notify users the alert via call

or E-mail. the attack modes include IP attack and Web Login.

IP Blacklist: if the device is attacked by IP attack. system will add IP to firewall and

Disable this IP access.
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(2) Added “AMI Settings” on “System Tools”

Path: System Tools --> AMI Settings

Descriptions: The Asterisk Manager Interface(AMI) is a socket interface that you
can use to get configuration and status information, request actions to be

performed, and be notified about things happening to calls.
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(3) Added “Mobility Extension” on Extensions

Path: Edit Extension

Descriptions:
1.If you set a mobile number as mobility extension, while you call in PBX with this
mobile number, the mobile phone will get all permission of the associated
extension. For example: dialing the extension, playing the voicemail.

2.When someone calls the associated extension, your mobile phone will ring
together, what you need is to set outbound route and Outbound Prefix
number.
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(4) Added extension Maximum Call Duration and global Maximum Call Duration

Path: Edit Extension and PBX Basic --> General Preferences

Descriptions: The absolute maximum amount of time permitted for a
cal

(5) Added dod and add bulk dod on “IP Trunk” and “VoIP Trunk”

Path: Trunks --> IP Trunk and Trunks --> VoIP Trunk

Descriptions: Add dod number and add bulk dod numbers to associated extension.
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(6) Added Extension CDR Report on Extension WebLogin

Path: Extension Web Login

Descriptions: Extension cdr lo

6.Optimization Descriptions

(1) none
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 Release Notes of Version 1/12/13.1.0.5

1.Introduction

(1) Firmware Version: 1.1.0.5, 12.1.0.5,13.1.0.5

(2) Applicable Model:MUC1004,MUC2008,MUC2016

(3) Release Date: Dec 03,2015

CHANGES SINCE FIRMWARE RELEASE 1/12/13.1.0.2

2.New Features

(1) Added “System Prompt Settings” on “Voice Management”.

(2) Added support for phone provisioning of Akuvox phone.

(3) Added the feature of “key as send” for Grandstream phones.

3.Optimization

(1) Optimized the feature of update password, allow special characters.

(2) Optimized the feature of special characters are allowed in “Alert-Info”.

4.Bug Fixes

(1) Fixed the issue that the Office Hours and Holiday cannot work properly.

(2) Fixed the issue that the extension page display abnormal when extension
account login first then login admin account.

(3) Fixed the issue that the changes for “Email Attachment”, “Play CID”, ”Play
Envelope”, ”Delete Voicemail” settings cannot take effect(PBX

Basic->Extensions. Edit).

(4) Fixed the issue that the “Global Office Hours”(PBX Basic->General Preferences)
setting cannot be saved.

(5) Fixed the issue that the “Inbound Routes. Alert-Info” and “Queues.
Alert-Info” and “Ring Groups. Alert-Info” cannot work properly.

(6) Fixed the issue that the “Call Forward” Always send call to Voicemail setting
cannot work.

(7) Fixed the issue that the extension page update password cannot work.

(8) Fixed the dispaly that the GUI of Google Chromium browser press F5 to refresh,
then the web page was crash.

(9) Fixed the issue that the P2P mode of IAX trunk cannot work.

(10) Fixed the Phone Provisioning cannot manually add the configuration of existing
phone.
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(11) Fixed the Phone Provisioning cannot work properly when the PBX changes for IP
or SIP port.

(12) Fixed the Phone Provisioning cannot work properly when set the codecs
empty.

(13) Fixed the Phone Provisioning changes for ”Active” setting cannot take effect.

(14) Fixed the Grandstream phones set Key Settings can’t work normally.

(15) Fixed the Fanvil phones set time zone cannot take effect.

(16) Fixed the Fanvil phones set Key Settings cannot take effect.

(17) Fixed the Yealink phones set codes cannot take effect.

(18) Fixed the Yealink phones set line of Key Settings cannot take effect.

(19) Fixed the Htek phones set codecs empty cannot be saved successfully.

(20) Fixed the Htek phones Line setting cannot take effect.

(21) Fixed the Htek phones configure Key settings cannot take effect.

(22) Fixed the Aastra phones Top Keys and Line settings cannot take effect.

(23) Fixed the Aastra phones set IP for DHCP mode cannot take effect.

(24) Fixed the Snom phones extension Line settings cannot take effect.

(25) Fixed the Cisco phones set time zone part cannot take effect.

(26) Fixed the Cisco phones set part of the spa model cannot take effect.

(27) Fixed the Cisco phones set Key Settings cannot take effect.

5.New Features Descriptions

(1) Added upload “System Prompt Settings” on “Voice Management”.

Path: Voice Management->System Prompts Settings

Descriptions:

With this feature, you can upload the system prompts.
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(2) Added support for phone provisioning of Akuvox phone.

Path: Phone Provisioning->Phones

Descriptions:

We can configuration Akuvox phones in Phone Provisioning.

(3) Added the feature of “key as send” for Grandstream phones.

Path: Phone Provisioning->Phones .Edit on the Grandstream phones and set
“key as send”.
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6.Optimization Descriptions

(1) Optimized the feature of update password, allow special characters.
Path: System Preferences->Password

(2) Optimized the feature of special characters are allowed in “Alert-Info”.

Path: PBX Inbound Call Control->Queues , Ring Groups
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 Release Notes of Version 1/12/13.1.0.2

1. Introduction

(1) Firmware Version: 1.1.0.2, 12.1.0.2,13.1.0.2

(2) Applicable Model:MUC1004,MUC2008,MUC2016

(3) Release Date: Nov 09,2015

CHANGES SINCE FIRMWARE RELEASE 1/12/13.1.0.1

2. New Features

(1)None

3. Optimization

(2)Optimized when adding extension and changing the extension number,
automatically revision Display Name, Call ID number, etc.

4. Bug Fixes

(1) Fixed the issue that the Inbound Route to Outbound Route cannot work.

(2) Fixed the issue that set the two Outbound Routes of the same Dial Patterns and
dial fail that system will appear problems.

(3) Fixed the issue that Record New Prompt cannot work (Voice Management - >
System Recording).

(4) Fixed the issue that the register multiple VOIP account to the same SIP server,
inbound route always match to the first account.

(5) Fixed the issue that Call Pickup, Attended Transfer, Blind Transfer, One Touch
Record, Call Parking for disabled cannot take effect.

(6) Fixed the issue that the IAX2 extension Call Pickup cannot work.

(7) Fixed the issue that the SIP trunk P2P mode cannot work.

(8) Fixed the issue that VOIP Trunk continue to send registration when deleted
the VOIP Trunk.

(9) Fixed the issue that changes for Tos video and Cos video setting cannot take
effect (PBX Advanced Settings -> SIP Settings ->QOS)

(10) Fixed the issue that changes for Feature Digit Timeout setting cannot take
effect (PBX Basic->Genera IP references)

5. New Features Descriptions

(1)None

6. Optimization Descriptions

(1) Optimized when adding extension and changing the extension number,
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automatically revision Display Name, Call ID number ,etc.

Path: PBX Basic->Extension
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 Release Notes of Version 1/12/13.1.0.1

1. Introduction

(1) Firmware Version: 1.1.0.1, 12.1.0.1,13.1.0.1

(2) Applicable Model:MUC1004,MUC2008,MUC2016

(3) Release Date: Nov 02,2015

CHANGES SINCE FIRMWARE RELEASE 1/12/13.1.0.0

2. New Features

(1)Added SIP prack and early media focus.

3. Optimization

(1)None

4. Bug Fixes

(1) Fixed the issue that T.38 fax for SIP trunk cannot work properly.

(2) Fixed the issue that T.38 -> T.30 cannot work.

(3) Fixed the issue that cannot dial to IAX2extension.

(4) Fixed the issue that changes for “Auto Answer” on Grandstream phones
cannot take effect.

(5) Fixed the issue that changes for “Call Waiting” on Grandstream phones
cannot take effect.

(6) Fixed the issue that changes for “Keys Settings” on Grandstream phones
cannot take effect.

(7) Fixed the issue that changes for GMT-12 on Grandstream phones cannot take
effect.

(8) Fixed the issue that unable to delete the configured phones in Phone
Provisioning.

(9) Fixed the issue that Phone Provisioning cannot scan all phones within a local
area network(LAN).

(10) Fixed the issue that Phone Provisioning for Fanvil phones cannot work.

(11) Fixed the issue that add multiple extensions, it will not begin to increase
extensions from the specified extension number.

(12) Fixed the issue that changes for Associated Email cannot be saved l (PBX Basic
-> Extensions. Edit -> Other -> Fax Configuration -> Associated Email).

5. New Features Descriptions

(1) Added SIP prack and early media focus.

Path: PBX Advanced Settings -> SIP Settings -> Custom Settings
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Descriptions: If you want use SIP prack and earlymediafocus, you can setting on
SIP Settings.

6. Optimization Descriptions

(1)None

http://www.maxincom.com/


MAXINCOM TECHNOLOGYCO.,LTD
www.maxincom.com

86

 Release Notes of Version 1/12/13.1.0.0

1. Introduction

(1) Firmware Version: 1.1.0.0, 12.1.0.0,13.1.0.0,

(2) Applicable Model:MUC1004,MUC2008,MUC2016

(3) Release Date: Oct 26,2015

CHANGES SINCE FIRMWARE RELEASE 1/12/13.0.0.15

2. New Features

(1) Added support for phone provisioning of
Aastra,Cisco,Fanvil,Grandstream,Htek,Panasonic,Polycom,Snom,Yealinkphones.

(2) Added the feature of PIN Users.

(3) Added the feature of Dial by Name.

(4) Added the feature of Feature Digit Timeout.

(5) Added the feature of Bulk add extensions.

(6) Added the feature of FAX detection.

(7) Added the feature of GSM module detection.

3. Optimization

(1)None

4. Bug Fixes

(1) Fixed the issue that Name or Number configured on Extension, IVR, Ring Groups,
Conferences, Outbound Routes, Inbound Routes, Paging and Intercom starting with
0 cannot be deleted successfully.

(2) Fixed the issue that the extension password will be covered by the browser
cookie’s password(PBX Basic -> Extensions. Edit).

(3) Fixed the display that the GUI of Callback was defective when it was configured.

5. New Features Descriptions

(1) Added support for phone provisioning of
Aastra,Cisco,Fanvil,Grandstream,Htek,Panasonic,Polycom,Snom,Yealink
phones.

Path: Phone Provisioning->Phones
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(2) Added the feature of PIN Users.

Path: PBX Advanced Settings->PIN Users
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(3) Added the feature of Dial by Name.

Path: PBX Inbound Call Control->IVR

Path: PBX Inbound Call Control->Queues.
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Path: PBX Inbound Call Control-> Ring Groups.
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(4) Added the feature of Feature Digit Timeout.

Path: PBX Basic->General Preferences

(5) Added the feature of Add bulk extensions.

Path: PBX Basic->Extensions
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(6) Added the feature of FAX detection.

Path: PBX Basic->Extensions. Edit in extension 102, and Fax Associated
Email address.
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(7) Added GSMmodule function.

Path: Trunks->Physical Trunk

6. Optimization Descriptions

(1)None
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 Release Notes of Version 1/12/13.0.0.15

1. Introduction

(1) Firmware Version: 1.0.0.15, 12.0.0.15, 13.0.0.15

(2) Applicable Model:MUC1004,MUC2008,MUC2016

(3) Release Date: Sep 08,2015

CHANGES SINCE FIRMWARE RELEASE 1/12/13.0.0.13

2. New Features

(1)None

3. Optimization

(1)Optimized of limited special characters.

4. Bug Fixes

(1) Fixed the display that the GUI of CDR Report was defective.

(2) Fixed the display that the GUI of Match Pattern and Strip of Outbound Routes
display dislocation.

(3) Fixed the display that the GUI of Outbound Routes Math Pattern
input‘-‘ character was defective.

5. New Features Descriptions

(1)None

6. Optimization Descriptions

(1)Optimized of limited special characters.
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 Release Notes of Version 1/12/13.0.0.13

1. Introduction

(1) Firmware Version: 1.0.0.13, 12.0.0.13,13.0.0.13

(2) Applicable Model:MUC1004,MUC2008,MUC2016

(3) Release Date: Aug 18,2015

CHANGES SINCE FIRMWARE RELEASE 1/12/13.0.0.12

2. New Features

(1)None

3. Optimization

(1) Optimized the feature of extension increased to 50 users from32.

(2) Optimized the display of Web GUI was defective after upgrade.

4. Bug Fixes

(1) Fixed the issue that the multiple user login on different computers, the latter
after the success login, the former will be logged out.

(2) Fixed the issue that the configured the transfer number in Call Forward and
configured Call Forward always to voicemail cannot take effect.

(3) Fixed the issue that Packet Capture cannot work properly (System Tools ->
Packet Capture).

(4) Fixed the display that GUI of General Preferences Ring Timeout was defective.

(5) Fixed the issue that dial *80 cannot work without create Paging and Intercom.

5. New Features Descriptions

(1)None

6. Optimization Descriptions

(1) Optimized the feature of extension increased to 50 users from32.

(2) Optimized the browser cache result in page fault after upgrade.
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